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本書は一般の方々の便宜のため有志により作成されたもので、Atmel社とは無関係であることを御承知ください。しおりの[はじめ
に]での内容にご注意ください。

応用記述

AVR3006 : QT600-ATxmega128A1でのQTouch構成器練習手引き

Atmel QTouch
要点

● 知識ﾚﾍﾞﾙ : 中間
● PC基盤 : Windows® 2000, Windows XP, Windows Vista®, Windows 7
● ﾊｰﾄﾞｳｪｱ必要条件:
 ● Atmel® QTTM600(完全ｷｯﾄ)
● ｿﾌﾄｳｪｱ必要条件:
 ● Atmel Studio 6.0.1843またはそれ以降
 ● Atmel Studio 6用のQTouch構成器拡張5.0.407またはそれ以降
 ● Atmel Studio 6用のQTouchﾗｲﾌﾞﾗﾘ拡張5.0.1082またはそれ以降
● この手引き内の全課題完了のための予想時間 : 4時間
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1. 始めに
この資料の目的は接触ﾌﾟﾛｼﾞｪｸﾄを開発するためにAtmel QTouch構成器(Composer)に精通することです。QTouch構成器はAtmel 
Studio 6の拡張です。Atmel QTouchｽｰﾂ(Suite)はAtmel Studio 6、Atmel QTouch構成器、Atmel QTouchﾗｲﾌﾞﾗﾘ、Atmel QT600開
発ｷｯﾄの核解決策を含みます。実地訓練は4つの課題に分けられます。各課題は簡単な理解のため、更に個別項目に分けられま
す。

1.1. Atmel Studio 6 - ﾃﾞﾊﾞｯｶﾞと書き込み器

Atmel Studio 6はAVR®とSAMのﾏｲｸﾛ ｺﾝﾄﾛｰﾗ用の応用を書き、ｼﾐｭﾚｰﾄし、そしてﾃﾞﾊﾞｯｸﾞするための専門家用統合開発環境(IDE)
です。これはAVRとSAMの全ての道具のﾌﾟﾛｸﾞﾗﾐﾝｸﾞ ｲﾝﾀｰﾌｪｰｽを含みます。

付加機能:

● 全てのAtmel 8ﾋﾞｯﾄと32ﾋﾞｯﾄのAVR MCUを支援
● SAM MCUを(ｼﾐｭﾚｰｼｮﾝなし)支援 (Atmel ARM®に基づくﾏｲｸﾛ ｺﾝﾄﾛｰﾗ)
● 統合されたQTouch分析器(Analyzer)
● 統合されたCｺﾝﾊﾟｲﾗ
● 新しいﾌﾟﾛｼﾞｪｸﾄ ｳｨｻﾞｰﾄﾞと聡明なｴﾃﾞｨﾀ
● ASF支援

1.2. QTouch構成器(Composer)

QTouch構成器は単に少しのｸﾘｯｸで使用者に接触ﾌﾟﾛｼﾞｪｸﾄの作成を許す、Atmel Studio 6内に統合された拡張です。QTouch構成
器はﾌﾟﾛｼﾞｪｸﾄを作成してｳｨｻﾞｰﾄﾞを通して提供される入力に基づいて必要なﾌｧｲﾙを追加します。

1.3. QTouchﾗｲﾌﾞﾗﾘ(Library)

QTouchﾗｲﾌﾞﾗﾘは標準的なAtmel AVRとSAMのﾏｲｸﾛ ｺﾝﾄﾛｰﾗで接触応用を開発するためのｿﾌﾄｳｪｱ ﾗｲﾌﾞﾗﾘです。QTouch構成器
が適切なQTouchﾗｲﾌﾞﾗﾘを追加します。

1.4. QT600 - 接触ﾊｰﾄﾞｳｪｱ ｷｯﾄとｺｰﾄﾞ例

QT600は釦、摺動子、輪のための完全な接触開発ｷｯﾄです。この高度な開発基盤はAtmel接触技術での実験を設計者に許し、接触
製品を分析して確認する最も容易な方法を提供します。これはAtmelのQTouchとQMatrixの両採取法を支援します。これは1つの
USB給電ｲﾝﾀｰﾌｪｰｽ基板と、Atmel tinyAVR®、megaAVR®、AVR XMEGA®、UC3L系統のﾏｲｸﾛ ｺﾝﾄﾛｰﾗに相当する4つのMCU基
板、そして8、16、64ﾁｬﾈﾙを支援する3つの接触感知器基板と共にやって来ます。

Atmel QT600 MCU基板は未使用入出力ﾋﾟﾝへの容易なｱｸｾｽのためにAtmel STK®600へ接続することができます。けれども、
STK600は正しい機能のためにQT600ｷｯﾄに対して必要とされません。QT600はAtmel Studio 6、AVR QTouch Studio、Atmel QTouc 
hﾗｲﾌﾞﾗﾘによって完全に支援されます。

この実践訓練は以下の課題から成ります。

1. 全てのものを接続してﾊｰﾄﾞｳｪｱが正しく動くことを保証してください。

2. 感知器を形態設定し、仮想ｷｯﾄを構成設定し、そしてQTouch構成器(Composer)で使用するﾎﾟｰﾄを割り当てることによって有り合わ
せから接触ﾌﾟﾛｼﾞｪｸﾄを構成設定してください。

3. QTouch分析器(Analyzer)を使用して様々なﾊﾟﾗﾒｰﾀの簡単な説明を観察してください。

4. ﾃﾞｰﾀを記録するためにQTouch分析器を使用してください。

2. 必要条件

2.1. ｿﾌﾄｳｪｱ

以下の最終版がｲﾝｽﾄｰﾙされることを確実にしてください。

● Atmel Studio 6
● Atmel Studio 6用QTouch構成器(Composer)拡張
● Atmel Studio 6用QTouchﾗｲﾌﾞﾗﾘ(Library)拡張

QTouch構成器とQTouchﾗｲﾌﾞﾗﾘ拡張をﾀﾞｳﾝﾛｰﾄﾞするための段階は次の通りです。

 1. Tools⇒Extension Managerを選択することによって拡張管理部を開いてください。拡張管理部ｳｨﾝﾄﾞｳが開きます。

 2. 既定により、それはｲﾝｽﾄｰﾙされた拡張を表示します。

 3. "Available Downloads(利用可能なﾀﾞｳﾝﾛｰﾄﾞ)"任意選択をｸﾘｯｸしてください。

 4. "QTouch Library"を選んでﾀﾞｳﾝﾛｰﾄﾞ ｱｲｺﾝをｸﾘｯｸしてください。

 5. "Sign in to Extension Manager Dashboard"ｳｨﾝﾄﾞｳが開いて署名/登録を問います。

 6. 登録していなければ、どうぞ登録して"Sign in to Extension Manager Dashboard"ｳｨﾝﾄﾞｳを閉じてください。AtmelはあなたのEﾒｰﾙ
-IDに確認ﾒｰﾙを送るでしょう。あなたのﾒｰﾙ-IDを確認するためにそのﾘﾝｸをｸﾘｯｸしてください。

 7. Atmel Studioを再始動してください。

http://www.atmel.com/microsite/atmel_studio6/default.aspx
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 8. 段階1.～4.を繰り返してください。"Sign in to Extension Manager Dashboard"ｳｨﾝﾄﾞｳが開きます。Eﾒｰﾙ-IDと登録中に使用したﾊﾟ
ｽﾜｰﾄﾞを使用して署名してください。

 9. "QTouchﾗｲﾌﾞﾗﾘ"拡張がﾀﾞｳﾝﾛｰﾄﾞされて自動的にｲﾝｽﾄｰﾙされるでしょう。

10. QTouch構成器をｲﾝｽﾄｰﾙするため、段階1.～4.を繰り返し、"Available Downloads"任意選択で"QTouch Composer"を選んでDo 
wnload釦をｸﾘｯｸしてください。

11. Extension Manager Dashboardに署名後、"QTouch構成器"拡張が自動的にﾀﾞｳﾝﾛｰﾄﾞされてｲﾝｽﾄｰﾙされます。

注: 段階6.と7.は初回に登録する場合にだけ必要とされます。既に登録済みの場合、Eﾒｰﾙ-IDとﾊﾟｽﾜｰﾄﾞを提供してください。"Sign 
in to Extension Manager Dashboard"ｳｨﾝﾄﾞｳが閉じて自動的にﾀﾞｳﾝﾛｰﾄﾞが起きます。

2.2. QT600ｼｽﾃﾑ

図2-1. QT600ｼｽﾃﾑ

MCU基板と接触感知器基板は共に使用者接触ｼｽﾃﾑを構成します。Atmel QT600ｲﾝﾀｰﾌｪｰｽ基板はMCU基板に装着されたAtmel 
AVR MCUから生接触ﾃﾞｰﾀを流すのに使用されます。Atmel Studio内のQTouch分析器(Analyzer)はこの接触ﾃﾞｰﾀを可視化するた
めの前処理部として使用されます。

この実践訓練では以下を使用するつもりです。

● Atmel QT600 - USBｲﾝﾀｰﾌｪｰｽ基板
● Atmel QT600-ATxmega128A1-QT16 - MCU基板
● Atmel QTouch16 - 16ﾁｬﾈﾙQTouch感知器基板

2.2.1. 構成図

2.2.2. 回路図

図2-2. 構成図

QTouch16
感知器基板

QT600-
ATxmega128A1-

QT16基板
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USB
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図2-3. ﾋﾟﾝ回路図
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3. 割り当て
以下の作業に対して注意してください。

● 全ｹｰﾌﾞﾙ切断で開始してください(PCとQT600、QT600とMCU基板、MCU基板と感知器基板)。

● 2.1.項で一覧にされたｿﾌﾄｳｪｱの最終版がｲﾝｽﾄｰﾙされていることを確実にしてください。

● この応用記述と提携するｿｰｽ ｺｰﾄﾞ(AVR3006.zip)ﾌｧｲﾙをﾀﾞｳﾝﾛｰﾄﾞしてください。

● このzipﾌｧｲﾙはCompleted_TasksとExercisesのﾌｫﾙﾀﾞから成ります。Completed_Tasksﾌｫﾙﾀﾞは使用者参照用で、使用者参照用の
完了されたﾌﾟﾛｼﾞｪｸﾄから成ります。

● 使用者はこの割り当て章で記述される以下の段階によって自身のﾌﾟﾛｼﾞｪｸﾄを作成することもできます。

3.1. 課題1 : 道具接続と試験応用走行

3.1.1. 序説

この課題は全ての道具が接続されて意図されるように動くことを保証するように設計されます。この課題に対してｺｰﾄﾞを書くことは全く
必要とされません。以下の位置に存在するQT600_ATxmega128a1_qt16_gnu.hexﾌｧｲﾙを設定することができます。

 ..\Exercises\Task1\

これはMCUのﾌﾗｯｼｭ ﾒﾓﾘ内に直接書き込むことができます。QT600ｲﾝﾀｰﾌｪｰｽ基板上の釦を押して保持し、状態LEDが橙から赤色
に変わるまで(約5秒)それを押し続けてください。これはQT600を接触ﾃﾞﾊﾞｯｸﾞ動作から書き込み器動作に切り替えます。

QT600上の接触ﾃﾞｰﾀLEDは以下のように動作形態を示します。

● 接触ﾃﾞｰﾀLED 緑点灯 : 接触ﾃﾞﾊﾞｯｸﾞ動作 (通電後の既定動作形態)
● 接触ﾃﾞｰﾀLED 消灯 : 書き込み器動作

Atmel Studioのﾌﾟﾛｸﾞﾗﾐﾝｸﾞ ﾀﾞｲｱﾛｸﾞからQT600への接続を試みる前に接触ﾃﾞｰﾀLEDがOFFであることを確実にしてください。Atmel 
Studio 6またはそれ以降を使用してください。

より多くの詳細についてはQT600使用者の手引きを参照してください。これはAtmel Studioを開始して、Help⇒View Help⇒QT600 
User Guideを選択することによってｱｸｾｽできます。

3.1.2. Atmel Studio 6を使用する出力ﾌｧｲﾙのﾌﾟﾛｸﾞﾗﾐﾝｸﾞ

下の段階に従うことによって.HEXﾌｧｲﾙまたは.ELFﾌｧｲﾙを目的対象基板に設定することができます。

● 先に何れかの接続が行われていた場合にそれを切り離してください。

● QT600ｲﾝﾀｰﾌｪｰｽ基板にUSBｹｰﾌﾞﾙを接続してください。

● QT600にVTGﾍｯﾀﾞが装着されているのを確実にしてください。

● QT600のJTAGﾍｯﾀﾞとQT600-ATxmega128A1-QT16 MCU基板間に10芯ﾌﾗｯﾄ ｹｰﾌﾞﾙ
を接続してください。図3-1.を参照してください。

図3-1. JTAG接続

● 書き込み器動作に切り替えるためにAtmel QT600上の釦を押してください(約5秒)。

● Atmel Studio 6を開き、図3-2.で示されるようにTools⇒Device Programmingを選択するか、またはDevice Programmingｱｲｺﾝをｸﾘｯ
ｸしてください。

図3-2. ﾃﾞﾊﾞｲｽ ﾌﾟﾛｸﾞﾗﾐﾝｸﾞを開く

http://www.atmel.com/tools/atmelstudio.aspx
http://www.atmel.com/tools/atmelstudio.aspx
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● ToolをQT600とし、DeviceをAtmel ATxmega128A1とし、InterfaceをJTAGとして選択してください。適用(Apply)をｸﾘｯｸしてください。
図3-3.を参照してください。

● 基板設定(Board settings)ﾀﾌﾞへ行き、ﾃﾞﾊﾞｲｽのﾃﾞｰﾀｼｰﾄによって目的対象電圧を設定してください。最小電圧は1.8Vです。図
3-3.を参照してください。

図3-3. 目的対象電圧

● USBﾌﾟﾗｸﾞを再接続してください。

● 書き込み器動作に切り替えるためにAtmel QT600上の釦を再び押してください。

● 図3-3.で示されるようにToolをQT600とし、DeviceをAtmel ATxmega128A1とし、InterfaceをJTAGとして選択してください。適用
(Apply)をｸﾘｯｸしてください。

● 読み込み(Read)をｸﾘｯｸしてください。図3-4.で示されるようにIDEによってﾃﾞﾊﾞｲｽ識票(Device signature)と目的対象電圧(Target V 
oltage)が読まれることを確実にしてください。また、目的対象電圧がﾃﾞﾊﾞｲｽのﾃﾞｰﾀｼｰﾄによっていることも確実にしてください。最
小電圧は1.8Vです。

図3-4. ﾃﾞﾊﾞｲｽIDと電圧の読み取り
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● Memories任意選択を選び、Erase now(今すぐ消去)をｸﾘｯｸしてください。図3-5.を参照してください。

● 出力ﾌｧｲﾙ(QT600_ATxmega128a1_qt16_gnu.hex)に対する適切なﾊﾟｽを設定し、Program(書き込み)をｸﾘｯｸしてください。ﾌﾟﾛｸﾞﾗﾐﾝ
ｸﾞ(書き込み)は成功であるべきです。

図3-5. 目的対象ﾃﾞﾊﾞｲｽの消去とﾌｧｲﾙ書き込み

● Atmel QT600からUSBﾌﾟﾗｸﾞを切り離してください。

● ﾌﾟﾛｸﾞﾗﾐﾝｸﾞ ﾍｯﾀﾞ間のﾌﾗｯﾄ ｹｰﾌﾞﾙを取り外して接触ﾃﾞｰﾀ ﾍｯﾀﾞ間に10芯ｹｰﾌﾞﾙを装着してください。

● 接触ﾊﾟﾈﾙを接続してください。Atmel ATxmega128A1に対してはQTouch16ﾊﾟﾈﾙを使用してください。

● Atmel Studioで図3-6.で示されるように、または          ｱｲｺﾝをｸﾘｯｸすることによってQTouch分析器(Analyzer)を開いてください。

図3-6. QTouch分析器(Analyzer)を開く
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● USBｹｰﾌﾞﾙをQT600に繋げてください。QTouch分析器(Analyzer)は今や自動的にｷｯﾄへ接続されるべきです。USBｲﾝﾀｰﾌｪｰｽ基
板上の接触ﾃﾞｰﾀLEDは今や点滅を開始します。これは接触ﾃﾞｰﾀが送られつつあることを示します。

● QTouch分析器内のStart Reading(読み取り開始)釦をｸﾘｯｸしてください。

今や接触ﾃﾞｰﾀ信号と感知器の状態を見ることができます。図3-7.を参照してください。

図3-7. QTouch分析器(Analyzer)ｳｨﾝﾄﾞｳ

● 分析動作形態で、明灰色で表示される感知器は不活性で、ｷｯﾄはこれらの感知器へ
の接触に応答しません。明茶色で表示される感知器は活性な感知器で、ｷｯﾄはこれら
の感知器への接触に応答します。

● 活性な感知器への接触が検出される時には必ず、使用者が接触する場所を示す、緑
で満たされた円を見ることができます。

● 活性な感知器への接触がもはや検出されない時は感知器の色が再び明茶色に戻り
ます。

図3-8. 感知器状態

滑動部0 活性

輪0 接触
しかしAKSに
よって抑制

釦0 ⊿<閾値

滑動部1 不活性

釦1 検出

3.2. 課題2 : 新しいﾌﾟﾛｼﾞｪｸﾄ構成設定

3.2.1. 序説

この課題では新しいﾌﾟﾛｼﾞｪｸﾄを作成します。接触応用のためのﾌﾟﾛｼﾞｪｸﾄを作成するのにQTouch構成器(Composer)を使用する方法
を知ります。

3.2.2. ﾌﾟﾛｼﾞｪｸﾄ構成設定

● Atmel Studio 6を開いて新しいﾌﾟﾛｼﾞｪｸﾄを
作成してください。Atmel Studioが既に走行
中なら、File⇒New Projectを選択してくださ
い。図3-9.を参照してください。

図3-9. 新しいﾌﾟﾛｼﾞｪｸﾄ作成
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● ﾌﾟﾛｼﾞｪｸﾄ形式をInstalled Templates(ｲﾝｽﾄｰﾙされた雛形)から"GCC C QTouch Executable Project"として選んでください。ﾌﾟﾛｼﾞｪ
ｸﾄ ﾃﾞｨﾚｸﾄﾘ ﾊﾟｽとﾌﾟﾛｼﾞｪｸﾄ名を提供してOKをｸﾘｯｸしてください。図3-10.を参照してください。

図3-10. QTouchﾌﾟﾛｼﾞｪｸﾄ選択

● 図3-11.で示されるようにQTouch Project Builder(ﾌﾟﾛｼﾞｪｸﾄ構築部)ｳｨｻﾞｰﾄﾞの"Getting Started(開始に際して)"ｳｨﾝﾄﾞｳが開きます。
Next(次へ)をｸﾘｯｸしてください。

図3-11. QTouchﾌﾟﾛｼﾞｪｸﾄ構築部 - 開始に際して
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● "Select Sensor, Technology & Device(感知器、技術、ﾃﾞﾊﾞｲｽ選択)"ｳｨﾝﾄﾞｳが開きます。Button(釦)数を10とし、Wheel(輪)数を1と
し、Slider(摺動子)数を1として選択してください。Technology(技術)としてQTouchを選んでください。図3-12.で示されるようにﾃﾞﾊﾞｲ
ｽ ATxmega128A1を選んでNext(次へ)をｸﾘｯｸしてください。

図3-12. QTouchﾌﾟﾛｼﾞｪｸﾄ構築部 - 感知器、技術、ﾃﾞﾊﾞｲｽ選択

● Kit Design(ｷｯﾄ設計)ｳｨﾝﾄﾞｳが開きます。Kit image(ｷｯﾄ画像)任意選択で閲覧      釦をｸﾘｯｸしてください。..\Exercise\Task2ﾌｫﾙ
ﾀﾞで利用可能な"F002-QT600-PANEL-QT16-image"ﾌｧｲﾙを検索してOKをｸﾘｯｸしてください。図3-13.を参照してください。

図3-13. ｷｯﾄ画像選択
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● 図3-14.で示されるようにｷｯﾄの物理的なﾊﾟﾗﾒｰﾀと全般的なﾊﾟﾗﾒｰﾀを形態設定してください。

図3-14. ｷｯﾄ物性と接触全般ﾊﾟﾗﾒｰﾀ

● ｷｯﾄ画像によって釦、輪、摺動子を配置してください。

● ﾄﾞﾛｯﾌﾟ ﾀﾞｳﾝ ﾒﾆｭｰからButton 0(釦0)を選び、図3-15.で示されるようにPhysical(物性)と感知器特有ﾊﾟﾗﾒｰﾀを設定してください。

図3-15. 釦の物性とﾌｧｰﾑｳｪｱのﾊﾟﾗﾒｰﾀ

● 同様に、他の釦を形態設定してください。

● ﾄﾞﾛｯﾌﾟ ﾀﾞｳﾝ ﾒﾆｭｰからSlider 0(摺動子0)を選び、図3-16.で示されるように物性と感知器特有ﾊﾟﾗﾒｰﾀを設定してください。

図3-16. 摺動子の物性とﾌｧｰﾑｳｪｱのﾊﾟﾗﾒｰﾀ
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● ﾄﾞﾛｯﾌﾟ ﾀﾞｳﾝ ﾒﾆｭｰからWheel 0(輪0)を選び、図3-17.で示されるように物性と感知器特有ﾊﾟﾗﾒｰﾀを設定してください。

図3-17. 輪の物性とﾌｧｰﾑｳｪｱのﾊﾟﾗﾒｰﾀ

● 全ての感知器の物性と感知器特有ﾊﾟﾗﾒｰﾀの形態設定後、Next(次へ)をｸﾘｯｸしてください。"Assign IO Ports and Sensors(I/Oﾎﾟｰ
ﾄと感知器割り当て)"ｳｨﾝﾄﾞｳが開きます。

● SNSK1に対してﾎﾟｰﾄF、SNS1に対してH、SNSK2に対してJ、SNS2に対してKを選んでください。

● 図3-18.で示されるようにButton(釦)[0～7]がSNS1とSNSK1の対、Button[8,9]とSlider(摺動子)0とWheel(輪)0がSNS2とSNSK2の対で
あるように、     と     のｱｲｺﾝを使用して感知器を配置してください。Next(次へ)をｸﾘｯｸしてください。

図3-18. ﾎﾟｰﾄ割り当て
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● "Assign SNS and SMSK pins(SNSとSNSKのﾋﾟﾝ割り当て)"ｳｨﾝﾄﾞｳが開きます。図3-19.で示されるようにﾋﾟﾝが既に割り当てられてい
ない場合、Auto Assign(自動割り当て)をｸﾘｯｸしてください。Next(次へ)をｸﾘｯｸしてください。

図3-19. ﾋﾟﾝ割り当て

● "Advanced Options(高度な任意選択)"ｳｨﾝﾄﾞｳが開きます。Enable QDebug Interface(Ｑﾃﾞﾊﾞｯｸﾞ ｲﾝﾀｰﾌｪｰｽ許可)任意選択をﾁｪｯｸ
してｲﾝﾀｰﾌｪｰｽを"SW inplemented SPI(ｿﾌﾄｳｪｱ実装SPI)"として選択してください。図3-20.で示されるようにSPI_BB_SSに対してﾎﾟｰ
ﾄC4、SPI_BB_MOSIに対してﾎﾟｰﾄC5、SPI_BB_MISOに対してﾎﾟｰﾄC6、SPI_BB_SCKに対してﾎﾟｰﾄC7を選び、Next(次へ)をｸﾘｯｸして
ください。このｳｨﾝﾄﾞｳでDelay Cycles(遅延周期)を変更できることに注意してください。

図3-20. 高度な任意選択
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● 図3-21.で示されるように"Summary(要約)"頁は接触形態設定の要約を示します。要約はこのｳｨｻﾞｰﾄﾞで与えられた入力によること
を確実にしてください。全てのものが正しければFinish(終了)をｸﾘｯｸしてください。

図3-21. 要約

● 新しいﾌﾟﾛｼﾞｪｸﾄが作成されている間に次のような進捗ｳｨﾝﾄﾞｳを見るでしょう。

● 進捗ｳｨﾝﾄﾞｳ後、以下の図で示されるように作成されるでしょう。

● ﾌﾟﾛｼﾞｪｸﾄを構築してください。F7を押すか、Build⇒Build Solutionを選んでください。それはどんな異常もなく構築されるべきです。

● そこでｷｯﾄを接続して課題1で言及したように生成されたHEXﾌｧｲﾙを書き込んでください。

● Atmel StudioでAtmel QTouch分析器(Analyzer)を開始してください。

● ｷｯﾄに接続されたUSBｹｰﾌﾞﾙを切り離し、そして接続してください。

● ｷｯﾄがQTouch分析器に接続されたかを調べてください。

● Start Reading(読み取り開始)をｸﾘｯｸし、接触を検出できるかどうかを調べて、それをQTouch Analyzer(分析器)ｳｨﾝﾄﾞｳで見てくださ
い。Sensor Data(感知器ﾃﾞｰﾀ)ｳｨﾝﾄﾞｳで、参照基準、信号、ﾃﾞｰﾀの値と各感知器の状態を見ることができます。



AVR3006 : QT600-ATxmega128A1でのQTouch構成部練習手引き [応用記述] 15

3.2.3. 更なる説明

"touch.c"ﾌｧｲﾙ

これはQTouchﾗｲﾌﾞﾗﾘで定義された様々な接触関連関数のための周期的な関数呼び出しを含む
自動生成されたﾌｧｲﾙです。

"touch.h"ﾌｧｲﾙ

これは接触ﾗｲﾌﾞﾗﾘ、Qﾃﾞﾊﾞｯｸﾞ(QDebug)規約、ﾎﾟｰﾄなどによって使用される様々なｼﾝﾎﾞﾙ定義を含
む自動生成されたﾌｧｲﾙです。全般または感知器特有ﾊﾟﾗﾒｰﾀに何れかの変更をするにはQTouch 
Project Builder(QTouchﾌﾟﾛｼﾞｪｸﾄ構築部)ｳｨｻﾞｰﾄﾞを開いて対応するﾊﾟﾗﾒｰﾀを変更しなければなり
ません。右の図で示されるようにあなたのﾌﾟﾛｼﾞｪｸﾄ内の".qtdgn"ﾌｧｲﾙでﾀﾞﾌﾞﾙ ｸﾘｯｸを行うことに
よってｳｨｻﾞｰﾄﾞを開いてください。

● QTouch Project Builderｳｨｻﾞｰﾄﾞが開きます。

● 必要な変更を行ってください。

● あなたのﾌﾟﾛｼﾞｪｸﾄを構築してください。

● 修正された変更を検査してください。

注: QTouch Project Builderｳｨｻﾞｰﾄﾞを通して行われる更なるどんな変更もこれらのﾌｧｲﾙに直接行
われた変更を取り去るので、直接的にﾌｧｲﾙでﾊﾟﾗﾒｰﾀを編集することは推奨されません。

この課題で使用される関数呼び出しの殆どはかなり簡単で自己説明的です。最も複雑な行はqt_enable_key()関数です。故に、ここで
より親密に見えるようにします。

 Void qt_enable_key(channel_t channel,
  aks_group_t aks_group,
  threshold_t detect_threshold,
  hysteresis_t detect_hysteresis);

ﾊﾟﾗﾒｰﾀは次の通りです。

channel : ｷｰ感知器が使う何れかの接触ﾁｬﾈﾙ

aks_group : (何れかの場合に)感知器が属す何れかのAKS®群

detect_threshold : 接触報告に必要とされる最小差

detect_hysteresis : 一旦感知器が検出になると、信号値がdetect_thresholdに近い場合に感知器が震えて検出を誤るのを避けるため
に、それの閾値ﾚﾍﾞﾙがﾋｽﾃﾘｼｽ値によって減少されます。

摺動子と輪の宣言は以下のように同じﾊﾟﾗﾒｰﾀを持ちます。

 Void qt_enable_slider( void qt_enable_rotor(
  channel_t from_channel,  channel_t from_channel,
  channel_t to_channel,  channel_t to_channel,
  aks_group_t aks_group,  aks_group_t aks_group
  threshold_t detect_threshold,  threshold_t detect_threshold,
  hysteresis_t detect_hysteresis,  hysteresis_t detect_hysteresis,
  resolution_t position_resolution,  resolution_t angle_resolution,
  uint8_t position_hysteresis);  uint8_t angle_hysteresis);

摺動子と輪の宣言は次のように少し多くのﾊﾟﾗﾒｰﾀを持ちます。

from_channel : 回転子感知器での最初のﾁｬﾈﾙ

to_channel : 回転子感知器での最後のﾁｬﾈﾙ

aks_group : (何れかの場合に)感知器が属す何れかのAKS群

detect_threshold : 接触報告に必要とされる最小差

detect_hysteresis : 一旦感知器が検出になると、信号値がdetect_thresholdに近い場合に感知器が震えて検出を誤るのを避けるた
めに、それの閾値ﾚﾍﾞﾙがﾋｽﾃﾘｼｽ値によって減少されます。

position_resolution : 報告される位置値の分解能

angle_resolution : 報告される角度値の分解能

position_hysteresis : 報告される位置値のﾋｽﾃﾘｼｽ

angle_hysteresis : 報告される角度値のﾋｽﾃﾘｼｽ
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3.3. 課題3 : 分析動作

3.3.1. 序説

● 分析動作は接続されたｷｯﾄの拡縮可能な画像を持ちます。それは釦押下、輪使用、摺動子使用のような接触事象を見せます。

● Atmel QTouch分析器(Analyzer)の分析動作はそれがPCに接続された時にｷｯﾄのための感知器割り当てに対するﾁｬﾈﾙを読み出
します。この情報を使用して、ｷｯﾄの画像が更新されます。

● 課題1で説明されたように、明灰色で表示される感知器は不活性で、明茶色で表示される感知器は活性な感知器です。使用者が
活性な感知器に接触する時に、接触を示す満たされた円が描かれます。満たされた円の大きさは差の値に比例し、閾値に達した
時に色を変えます。

● 活性な感知器への接触がもはや検出されない時に、感知器の色は再び明灰色に戻ります。使用者は分析中に、検出閾値、AKS
などのような感知器形態設定任意選択、最大ON持続時間、検出積分法などのようなｷｯﾄ形態設定任意選択を編集することができ
ます。

3.3.2. ｷｯﾄ/感知器形態設定

3.3.2.1. 感知器特有ﾊﾟﾗﾒｰﾀ変更

AKS群

● Atmel StudioでQTouch分析器(Analyzer)を開いてください。

● Kit/Sensor Properties(ｷｯﾄ/感知器ﾌﾟﾛﾊﾟﾃｨ)ｳｨﾝﾄﾞｳで、Button(釦)0を選んでAKS groupをAKS_GROUP_1として形態設定してくださ
い。Write to kit(ｷｯﾄへ書き込み)をｸﾘｯｸしてください。

● 同様に、Button5とButton9をAKS_GROUP_1として形態設定してください。

● そこで3つ全ての釦を同時に接触する場合、1つだけが検出になるでしょう。

● 感知器が共に近い場所や高い感度に設定される設計では接触がそれらの近くの場合に複数の感知器が同時に検出を報告する
かもしれません。意図する単一接触の決定を応用に許すため、接触ﾗｲﾌﾞﾗﾘはAKS群内に或る数の感知器を形態設定する能力を
使用者に提供します。

● 感知器群が同じAKS群の時に、最初に最強の感知器だけが検出を報告します。検出を報告する感知器は別の感知器の差がより
強くなっても、検出報告を続けます。感知器はそれの差がそれの検出閾値以下に落ちるまで検出に留まり、その後にAKS群内の
感知器がその上未だ検出ならば、最強のものが検出を報告します。

● また与えられたどの時間でも、各AKS群から1つだけの感知器が検出であることを報告されます。

検出閾値

● Kit/Sensor Properties(ｷｯﾄ/感知器ﾌﾟﾛﾊﾟﾃｨ)ｳｨﾝﾄﾞｳを開き、何れかの感知器を選んで検出閾値の値を変更してください。Write to 
kit(ｷｯﾄへ書き込み)をｸﾘｯｸしてください。

● 違う値でその感知器変更の感度がどうかを観測してください。

● より低い値はもっと大きな感度の感知器になります。

● 感知器の検出閾値は、それの信号が可能性のある接触検出と見做すそれの参照基準ﾚﾍﾞﾙ以下にどの位落ちなければならない
かを定義します。これは3～255間の範囲を持ちます。

全ての形態設定ﾊﾟﾗﾒｰﾀのより多くの詳細についてはQTouchﾗｲﾌﾞﾗﾘ使用者の手引きを参照してください。

http://www.atmel.com/dyn/resources/prod_documents/doc8207.pdf
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3.3.2.2. 全般感知器ﾊﾟﾗﾒｰﾀ変更

最大ON持続時間

● QTouch分析器(Analyzer)のGraph(図表)ｳｨﾝﾄﾞｳ上の      ｱｲｺﾝをｸﾘｯｸしてください。

● 図表でそれらを見るためにﾁｬﾈﾙ4の信号と参照基準値を選んでください。

● Graphｳｨﾝﾄﾞｳはﾁｬﾈﾙ4の信号と参照基準値を描きます。接触と非接触の間中、それらを観測してください。

● Kit/Sensor Properties(ｷｯﾄ/感知器ﾌﾟﾛﾊﾟﾃｨ)ｳｨﾝﾄﾞｳで、ﾄﾞﾛｯﾌﾟ ﾀﾞｳﾝ ﾘｽﾄからｷｯﾄを選び、MAX ON duration(最大ON持続時間)ﾊﾟﾗ
ﾒｰﾀを30に変更してください。Write to kit(ｷｯﾄへ書き込み)をｸﾘｯｸしてください。

● そこでｷｰを接触し、6秒後に感知器が再校正することを見てください。

● Kit/Sensor Propertiesｳｨﾝﾄﾞｳで、ﾄﾞﾛｯﾌﾟ ﾀﾞｳﾝ ﾘｽﾄからｷｯﾄを選び、MAX ON duration(最大ON持続時間)ﾊﾟﾗﾒｰﾀを0に変更してく
ださい。Write to kit(ｷｯﾄへ書き込み)をｸﾘｯｸしてください。

● 最大ON持続時間が0に設定された場合に接触は延長された時間で起きます。

最大ON時間=30

最大ON時間=0

接触を示す。 再校正

接触を示す。 非接触を示す。

意図せぬものが感知器に触れて延長された間隔の間の接触検出に帰着する場合、通常、それの機能を回復するために、おそらく数
秒の時間遅延後に感知器を再校正することが望まれます。最大ON持続時間計時器はそのような検出を監視します。

3.4. ﾃﾞｰﾀ記録

● ｷｯﾄを接続してQTouch分析器(Analyzer)を開いてください。

● Sensor Data(感知器ﾃﾞｰﾀ)ｳｨﾝﾄﾞｳでTrace(追跡)ﾀﾌﾞを選んでください。

● 下で示されるようにSave(保存)釦をｸﾛｯｸしてﾌｧｲﾙを望む場所に保存してください。

● Start Reading(読み取り開始)釦をｸﾘｯｸしてください。

● 望んだ持続時間または接触操作後にStop Reading(読み取り停止)釦をｸﾘｯｸしてください。

● そこで保存された".csv"ﾌｧｲﾙをMS Office Excelで開いてください。

● 何れかの表計算ﾂｰﾙで図表などを作成してﾃﾞｰﾀを分析することができます。

4. 要約
この実践訓練の主な目標はAtmel QT600でAtmel Studio 6とAtmel QTouch構成器(Composer)の使用方法を学ぶことです。

● ﾊｰﾄﾞｳｪｱ構成設定
● 有り合わせからﾌﾟﾛｼﾞｪｸﾄ作成
● "QTouch Project Builder(QTouchﾌﾟﾛｼﾞｪｸﾄ構築部)"ｳｨｻﾞｰﾄﾞを使用してｷｯﾄと接触ﾊﾟﾗﾒｰﾀを形態設定
● 全般任意選択と感知器特有ﾊﾟﾗﾒｰﾀ形態設定
● QTouch 分析器(Analyzer)を使用して感知器ﾃﾞｰﾀを分析
● Design Validation(設計確認)ｳｨｻﾞｰﾄﾞの使用
● ﾃﾞｰﾀの記録と分析

加えて、ﾃﾞﾊﾞｲｽ内にｺｰﾄﾞを書き込むためにAtmel Studio 6を使用する方法を学びました。
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5. Atmel技術支援ｾﾝﾀ
Atmelは以下の利用可能な多数の支援経路を持ちます。

 ｳｪﾌﾞ入り口 : http://support.atmel.no/ 全てのAtmelﾏｲｸﾛ ｺﾝﾄﾛｰﾗ
 Eﾒｰﾙ : touch@atmel.com 全ての接触製品
 Eﾒｰﾙ : avr@atmel.com 全てのAVR製品
 Eﾒｰﾙ : avr32@atmel.com 全ての32ﾋﾞｯﾄAVR製品

以下のｻｰﾋﾞｽへのｱｸｾｽを得るにはｳｪﾌﾞ入り口で登録してください。

● 豊富なFAQﾃﾞｰﾀﾍﾞｰｽへのｱｸｾｽ
● 技術支援要請の容易な依頼
● あなたの過去の全支援要請の履歴
● Atmelﾏｲｸﾛ ｺﾝﾄﾛｰﾗ時事通信
● 利用可能な練習と練習材料についての情報

6. 改訂履歴

資料改訂 日付 注釈

42043A 2012年10月 初版資料公開

http://support.atmel.no/
mailto:touch@atmel.com
mailto:avr@atmel.com
mailto:avr32@atmel.com
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